Training Document for Comprehensive Automation Solutions

Totally Integrated Automation (TIA)

**MODULE D17**

**PROFIBUS DP**

with

**Master CP 342-5DP/Slave ET 200S**
This document has been written by Siemens AG for training purposes for the project entitled "Siemens Automation Cooperates with Education (SCE)". Siemens AG accepts no responsibility for the correctness of the contents.

Transmission, use or reproduction of this document is only permitted within public training and educational facilities. Exceptions require the prior written approval by Siemens AG (Michael Knust michael.knust@siemens.com).

Offenders will be liable for damages. All rights, including the right to translate the document, are reserved, particularly if a patent is granted or utility model is registered.

We would like to thank the following: Michael Dziallas Engineering, the teachers at vocational schools, and all others who helped to prepare this document.
<table>
<thead>
<tr>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Preface ................................................................. 4</td>
</tr>
<tr>
<td>2. Notes on Using the CP 342-5DP ........................................ 6</td>
</tr>
<tr>
<td>3. Notes on Using the ET 200S with IM 151-1 HF ...................... 7</td>
</tr>
<tr>
<td>4. Starting Up the Profibus (Master CP 342-5DP/Slave ET200S) ........ 8</td>
</tr>
</tbody>
</table>

The symbols below are provided as a guide through Module D17:

- **i** Information
- **Programming**
- **Sample Exercise**
- **Notes**
1. PREFACE

In terms of its contents, Module D17 is part of the teaching unit entitled 'Industrial Fieldbus Systems'.

Learning Objective:

In Module D17, the reader learns how the PROFIBUS DP with a SIMATIC S7-300 - with the communication processor CP 342-5DP as master and the ET 200S as slave - is started up. Module D17 illustrates the method in principle, using a short example.

Prerequisites:

To successfully work through Module D17, the following knowledge is assumed:

- Knowledge in handling Windows
- Fundamentals of PLC programming with STEP 7 (for example, Module A3 - 'Startup' PLC Programming with STEP 7)
- Fundamentals of PROFIBUS DP (for example, Appendix IV - Basics of Fieldbus Systems with SIMATIC S7-300)
Hardware and software required

1. PC, operating system Windows 2000 Professional starting with SP4/XP Professional starting with SP1/Server 2003 with 600MHz and 512RAM, free hard disk storage 650 to 900 MB, MS Internet Explorer 6.0
2. Software STEP7 V 5.4
3. MPI interface for the PC (for example, adapter USB)
4. PLC SIMATIC S7-300 with the CP 342-5DP
   Sample configuration:
   - Power supply: PS 307 2A
   - CPU: CPU 314
   - Digital inputs: DI 16xDC 24V
   - Digital outputs: DO 16xDC 24V/0.5A
   - PROFIBUS communication processor CP 342-5DP
5. Distributed periphery ET 200S for PROFIBUS with 2 digital inputs and 4 digital outputs
   Sample Configuration:
   - Interface Module IM151-1HF
   - Power module PM-E DC 24V ...48V/AC 24V...230V
   - Electronic module: 2DI Standard DC 24V
   - Electronic module: 4DO Standard DC 24V/0.5A
6. PROFIBUS cable with 2 PROFIBUS connectors
2. NOTES ON THE USE OF CP 342-5DP

The PROFIBUS communication processor CP 342-5DP allows for connecting the SIMATIC S7-300 to the PROFIBUS with the protocol profile Decentral Periphery (DP).

The PROFIBUS parameters for the PLC are assigned and the PROFIBUS network is configured using the STEP7 software. However, for the CP342-5DP, the software "NCM S7 PROFIBUS" (already included in STEP7 V5.x!) is required. This provides the user with a uniform configuring tool for central as well as distributed configurations.

For the SIMATIC S7-300 with the CP342-5 as combi-master, the following protocol profiles are available:

- The DP interface as master or slave according to EN 50170. PROFIBUS-DP (distributed periphery) is the protocol profile for connecting distributed periphery/field devices with very fast response timing.
- SEND/RECEIVE interface (PLC/PLC) according to the SDA service (Layer 2 of PROFIBUS). SEND/RECEIVE (FDL interface) provides functions with which communication between SIMATIC S5 and S7 (with each other) and with the PC can be implemented simply and quickly.
- S7 functions. These provide optimized communication in the SIMATIC S7/M7/PC network.

With programmed FC block calls, the user program activates the transfer of the data areas for DP and FDL communication, and monitors its successful execution. The FC blocks needed for communication are stored in the “SIMATIC_NET_CP” library. To use this functions, the FC blocks have to be incorporated in (copied to) your "own" project.

Note: Here, the CP 342-5DP is used on the PROFIBUS as master.
3. NOTES ON USING THE ET 200S WITH IM 151-1 HF

The SIMATIC ET 200S is a decentral IO device configured in a highly modular mode. It can be operated with different interface modules:

- **IM 151-1 BASIC, IM 151-1 STANDARD** and **IM 151-1 FO STANDARD** for connecting a maximum of 63 IO modules (all types except PROFIsafe) to the PROFIBUS DP; alternatively, bus connection with RS 485 Sub-D connector or by means of integrated fiber-optic connection.

- **IM 151-1 HIGH FEATURE** for connecting a maximum of 63 IO modules (all types, including clocked mode for PROFIsafe) to PROFIBUS-DP; bus connection with RS485 Sub-D connector.

- **IM 151-3 PN** for connecting a maximum of 63 IO modules (all types, including the clocked mode for PROFIsafe) to PROFINET IO controllers; bus connection by means of RJ45 connector.

- **IM 151-7/F-CPU, IM 151-7/CPU or IM 151-7/CPU FO** for connecting a maximum of 63 IO modules (all types; PROFIsafe only with IM151-7/F CPU) to PROFIBUS DP; alternatively bus connection with RS 485 Sub-D connector or by means of an integrated fiber-optic connection; with integrated CPU 314 of the SIMATIC S7-300, for preprocessing process data.

The following IO modules can be used:

- **Power modules** for individual grouping of load and encoder supply voltages and their monitoring.

- **Digital electronic modules** for connecting digital sensors and actuators.

- **Analog electronic modules** for connecting analog sensors and actuators.

- **Sensor module** for connecting IQ sense sensors.

- **Technology modules** Electronic modules with integrated technological functions, such as counting, positioning, data exchange, etc.

- **Frequency converters and motor starter modules**

For training purposes, an integrated system is available, suitable for teaching many technologies.

**Notes:**

- In Module D16, the interface module IM151-1 HF (HIGH FEATURE) is used as PROFIBUS DP slave.

- The PROFIBUS address is set, binary-coded, on 8 switches at interface module IM151-HF. The lowest switch has to be on OFF. A number is assigned to each of the other switches. These numbers add up to the PROFIBUS station address. If the PROFIBUS address is changed, the new setting will be accepted only after voltage returns. Therefore, the interface module IM151-1 HF has to be switched off, and then switched on again.
4. STARTING UP PROFIBUS (MASTER CP 342-5DP/SLAVE ET200S)

Below, the startup of a single master system with the SIMATIC S7-300 - with the CP342-5DP as master and the ET200S as slave- is described.

To test the configuration, a program is written. In this program, an indicator lamp P1 is activated when two buttons, S0 and S1, are operated simultaneously.

**Assignment List:**

- I0.0  S0  Button Selection 1
- I0.1  S1  Button Selection 2
- O0.0  P1  Indicator lamp

1. The central tool in STEP 7 is the 'SIMATIC Manager'. Here, it is called with a double click. (→ SIMATIC Manager)

2. STEP7 programs are managed in projects. We are now setting up such a project. (→ File → New)
3. The project is now assigned the 'Name' 'ET200S_CP'. (→ ET200S_CP → OK)

4. Highlight your project and insert a 'PROFIBUS Subnet'. (→ ET200S_CP → Insert → Subnet → PROFIBUS).
5. Then, a 'SIMATIC 300 Station' is inserted. (→ Insert → Station → SIMATIC 300 Station)

6. With a double click, open the configuration tool for 'Hardware'. (→ Hardware)
7. Open the hardware catalog by clicking on the symbol (→).
   There, arranged in the following directories:
   PROFIBUS DP, PROFIBUS PA, PROFINET IO, SIMATIC 300, SIMATIC 400,
   SIMATIC HMI Station, SIMATIC PC Based Control 300/400, and SIMATIC PC Station,
   all racks, modules and interface modules are provided for configuring your hardware.
   Insert 'Rail' with a double click. (→ SIMATIC 300 → RACK-300
   → Rail)

After that, a configuration table for configuring Rack 0 is displayed automatically.
8. From the hardware catalog, you can now select all modules that are also in your real rack, and insert them in the configuration table. To this end, click on the name of the respective module, hold the mouse key and drag the module to a line in the configuration table.

We are starting with the power unit 'PS 307 2A'. (→ SIMATIC 300 → PS-300 → PS 307 2A)

Note: If your hardware differs from the one displayed here, simply select the corresponding modules from the catalog and insert them in your rack. The order numbers of the individual modules -that are also indicated on the components- are displayed in the footer of the catalog.
9. Next, we drag the CPU 314 to the second slot. The order number and the version of the CPU can be read off the front of the CPU. (SIMATIC 300 → CPU-300 → CPU 314 → 6ES7 314-1AE04-0AB0 → V1.2)
10. Now, we drag the input submodule for 16 inputs to the 4th slot. The order number of the submodule can be read off the front. (SIMATIC 300 → SM300 → DI-300 → SM 321 DI16xDC24V).

Note: Slot No. 3 is reserved for interface modules and remains empty for that reason. The module’s order number is displayed in the footer of the catalog.
11. Next, we drag the output submodule for 16 outputs to the 5th slot. The order number of the submodule can be read off the front. (→ SIMATIC 300 → SM300 → DO-300 → SM 322 DO16xDC 24V/0.5A).

Note: The order number of the module is displayed in the footer of the catalog.
12. Now, we drag the communication processor for PROFIBUS 'CP 342-5DP' to the 6th slot. The order number and the version of the submodule can be read off the front. (→ SIMATIC 300 → CP-300 → PROFIBUS → CP 342-5 → 6GK7 342-5DA02-0XE0 → V4.0).

13. When entering the communication processor, the following window appears. In this window, assign a PROFIBUS address to the CP 342-5DP and select the PROFIBUS network that has already been created. If you want to modify the parameters of the PROFIBUS network, highlight it and then click on 'Properties'. (→ Properties)
14. Now you can select the 'Highest PROFIBUS Address' (here → 126), the 'Transmission Rate' (here → 1.5 Mbit/s) and the 'Profile' (here → DP). (→ OK → OK)

15. Next, first the addresses of the communication processor are noted down in the periphery address space of the CPU (here: PI 288...303/PO 288..303). Then, the properties of the CP are selected by double clicking on the 'CP 342-5DP'. The 'Operating Mode' is then set to 'DP Master' and accepted with 'OK'.
(→ CP 342-5 → Operating Mode → DP Master → OK)
16. Then, to the right of the CP342-5DP, a bar appears - the so called 'Master system' - where you can arrange PROFIBUS slaves. This is done by clicking on the desired module (here the 'ET 200S' with 'IM151-1 HF') in the hardware catalog in the path 'PROFIBUS-DP', and dragging it to the master system. (→ PROFIBUS DP → ET 200S → IM151-1 HF → 6ES7 151-1BA00-0AB0)

17. When entering the slave, the following window appears. In this window, assign a PROFIBUS address to the slave. The address has to be identical with the address that you set at the switches of the IM151-1 HF (→ 3 → OK)
18. From the hardware catalog, you can now select all additional modules that are inserted in your real ET200S and add them to your configuration table. To this end, click on the name of the respective module, hold the mouse key, and drag the module to a line in the configuration table. We are starting with the power module ‘PM-E DC24V...48V/AC24...230V’ that is dragged to Slot 1. (➔ PROFIBUS-DP → ET 200S → IM151-1 HF → PM → PM-E DC24V...48V/AC24...230V)

19. Next, we are dragging the digital input submodule ’2DI DC24V ST’ to the 2nd slot. The order number and the version can be read off the module. (➔ PROFIBUS-DP → ET 200S → IM151-1 HF → DI → 2DI DC 24V ST)
20. Now we are dragging the digital output module ‘4 DO DC24V/0.5A ST’ to the 3rd slot. The order number and the version can be read off the module. (→PROFIBUS-DP → ET 200S → IM151-1 HF → DO → 4 DO DC 24V/0.5A ST)
21. The addresses of the inputs and the outputs on the ET 200S can now be noted down (here: I 0.0...0.1/O 0.0...0.3). Addresses are assigned automatically in the sequence in which the slaves were entered.

**Note:** The addresses specified here are the input and output addresses within the communication processor. These addresses can not be accessed directly in the program of the CPU. First, by means of FC blocks, the input/output areas have to be transferred to address areas of the CPU.

By clicking on ' and ' respectively, the configuration table is first saved and compiled, and then loaded to the PLC. The key switch on the CPU should be in the STOP position! (→ →)

22. The CPU 314 is then confirmed as the destination module of the load process. (→ OK)
23. In the dialog window below, you can 'Display' the devices that are connected in the network. The station address of the CPU in the MPI network is then selected. If you are connected to only one CPU, accept with 'OK'. (→ Display → OK)

24. After the hardware configuration is loaded, we can start generating the program. From the 'SIMATIC Manager', open 'OB1' with a double click. (→ OB1)
25. Optional: enter the OB1 properties for documentation, and accept with 'OK'.
(→OK)
With programmed FC block calls, the user program activates the transfer of the data areas for the inputs and outputs of the PROFIBUS DP slaves. These FCs also monitor the successful execution. The FC blocks needed for communication are stored in the “SIMATIC_NET_CP” library. To use these functions, they have to be incorporated into (copied to) your “own” project.

The FC block **DP-SEND** transfers data from the user program in the CPU to the PROFIBUS CP. Depending on the operating mode of the PROFIBUS CP, DP-SEND has the following meaning:

- **When used in the DP Master**
  The block transfers the data of a specified DP output area to the PROFIBUS CP for output to the distributed IO.

- **When used in the DP slave**
  The block transfers the data of a specified DP data area of the CPU to the send buffer of the PROFIBUS CP for transmission to the DP master.

When calling the FC block DP SEND, the following parameters have to be entered in succession:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value Range</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPLADDR</td>
<td>WORD</td>
<td></td>
<td>Module start address (in STEP7, is provided in the configuration table)</td>
</tr>
<tr>
<td>SEND</td>
<td>ANY</td>
<td></td>
<td>Specifies address and length of the DP send area (the address can refer to IO areas, flag areas, and data block areas)</td>
</tr>
<tr>
<td>DONE</td>
<td>BOOL</td>
<td>0: - 1: New data</td>
<td>Status parameter indicates whether the request was processed without fault.</td>
</tr>
<tr>
<td>ERROR</td>
<td>BOOL</td>
<td>0: - 1: Error</td>
<td>Error indication</td>
</tr>
<tr>
<td>STATUS</td>
<td>WORD</td>
<td></td>
<td>Status indication</td>
</tr>
</tbody>
</table>
The FC block DP-RECV receives data via PROFIBUS-DP. Depending on the operating mode of the PROFIBUS-CP, the DP-RECV has the following meaning:

- **When used in the DP Master**
  The block accepts process data of the distributed IO as well as status information into a specified DP input area.

- **When used in the DP Slave**
  The block accepts the DP data -transmitted by the DP master- from the receive buffer of the PROFIBUS CP into a specified DP data area of the CPU.

When calling the FC block DP-RECV, the following parameters have to be entered in succession:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value Range</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPLADDR</td>
<td>WORD</td>
<td></td>
<td>Module start address (in STEP7, is provided in the configuration table)</td>
</tr>
<tr>
<td>RECV</td>
<td>ANY</td>
<td></td>
<td>Specifies the address and the length of the DP receive area (the address can refer to IO areas, flag areas, and data block areas)</td>
</tr>
<tr>
<td>NDR</td>
<td>BOOL</td>
<td>0: - 1: New data accepted</td>
<td>The status parameter indicates whether new data was accepted.</td>
</tr>
<tr>
<td>ERROR</td>
<td>BOOL</td>
<td>0: - 1: Error</td>
<td>Error indication</td>
</tr>
<tr>
<td>STATUS</td>
<td>WORD</td>
<td></td>
<td>Status indication</td>
</tr>
<tr>
<td>DPSTATUS</td>
<td>BYTE</td>
<td></td>
<td>DP status indication</td>
</tr>
</tbody>
</table>
26. With ‘LAD, STL, FBD – Program S7 blocks’, you now have an editor with which you can generate your STEP7 program accordingly. To this end, OB1 has already been opened with the first network. To generate your initial operations, highlight the first network. Now you can write your STEP7 program. In STEP7, individual programs are usually arranged in networks. A new network is opened by clicking on the network symbol 'Net'.

Here, in Network 1, the inputs of the DP slaves are entered with the block 'DP_RECV'. You can drag this block, in the catalog, from the 'Library Blocks' to your network. (→ Libraries → SIMATIC_NET_CP → CP 300 → FC2 DP_RECV)

In Network 3, the outputs of the DP slaves are written to with the block 'DP_SEND'. You can drag this block, in the catalog, from the 'Library Blocks' to your network. (→ Libraries → SIMATIC_NET_CP → CP 300 → FC1 DP_SEND)

Now, save OB1. (→)

---

**MDM-7/P (OB1) 37702-CM_CP 300_32(1)(4/12/11)**

**OB1: "Main Program Sleep (Cycle)"**

**Network 1: Inputs of the PROFIBUS DP- slaves simulate**

CALL "DP_RECV"  //FC1
CLADDB:"DP_RECV"  //Deviceprogrammabld der CP aus der Hardwarekonfiguration
STE: 64.0 STTS 1  //Adressebereich fur die Eingabe der DP-Slave
MSG: 69.0  //Startbild
E32OB:"MB9.0"  //Fehlerbild
E32OB:"MB9.1"  //Staetbild
E32OB:"MB9.5"  //Staetbild

**Network 2: "Main program (Network)"**

**Network 3: Outputs of the PROFIBUS DP- slaves simulate**

CALL "DP_SEND"  //FC1
CLADDB:"DP_SEND"  //Deviceprogrammabld der CP aus der Hardwarekonfiguration
STE: 64.0 STTS 1  //Adressebereich fur die Ausgabe der DP-Slave
DBM:"MB9.0"  //Staetbild
E32OB:"MB9.1"  //Fehlerbild
E32OB:"MB9.5"  //Staetbild
STEP7 Program in OB1:

Network 1 : Enter inputs of the PROFIBUS DP slaves to the PI1 starting with IB64
CALL "DP_RECV" //FC2
  CPLADDR :=W#16#120 //Module start address of the CP from
                  //hardware configuration
  RECV :=P#E  64.0 BYTE 1 //Address area for the inputs of the DP slaves
  NDR :=M99.0 //Control bit for request processing
  ERROR :=M99.1 //Error bit
  STATUS :=MW95 //Status display for diagnostic and error bit
  DP-STATUS :=MB97 //Status byte for PROFIBUS connection

Network 2 : User Program
U I 64.0 //Button Selection 1
U I 64.1 //Button Selection 2
= O 64.0 //Indicator lamp

Network 3 : Write to outputs of the PROFIBUS DP slaves from the PIO starting with OB64
CALL "DP_SEND" //FC1
  CPLADDR :=W#16#120 //Module start address of the CP from
                  //hardware configuration
  SEND :=P#A  64.0 BYTE 1 //Address area for the outputs of the DP slaves
  DONE :=M89.0 //Status bit for request processing
  ERROR :=M89.1 //Error bit
  STATUS :=MW85 //Status display for diagnostic and error bit

Note: Here, an ET200S with 1 byte input data and 1 byte output data is incorporated by
means of a CP342-5 DP on Slot 6 (module start address Decimal: 288/Hexa-decimal: 120).
The input data is to be located in the input area starting with IB 64; and from the output area starting
with OB 64, the data is to be written to the ET200S.
It is important that the data of all DP slaves defined in the hardware configuration is incorporated in
the blocks DP_RECV and DP_SEND, whereby all DP slaves are combined in a DP_RECV and a
DP_SEND.
In this case, the area that is read/written to can be larger, but not smaller than the address area of
the DP slaves!!
The addresses of individual submodules are provided in the hardware configuration.
27. Now, the STEP7 program has to be loaded to the PLC. In our case, this is done from the 'SIMATIC Manager'. There, in the folder 'Blocks', highlight 'OB1' and the FCs 'FC1' and 'FC2' and click on Load '. The key switch of the CPU should be on STOP! (SIMATIC Manager → Blocks → OB1 → FC1 → FC2 →).

28. By setting the key switch to RUN, the program is started.